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Preface

Oracle Communications Connector for Microsoft Outlook enables Oracle Communications Unified Communications Suite features and functionality to be available through Microsoft Outlook.


Audience

This documentation is intended for system administrators whose responsibility includes Connector for Microsoft Outlook. This guide assumes you are familiar with the following topics:

	
System administration and networking


	
Outlook Administration


	
Messaging Server, Calendar Server, and Address Book protocols and standards


	
Directory Server and LDAP


	
General deployment architectures








Related Documents

For more information, see the following documents in the Oracle Other Product One Release 7.0 documentation set or in the Oracle Other Product Two Release 6.1 documentation set:

	
Connector for Microsoft Outlook Release Notes


	
Connector for Microsoft Outlook Installation Guide


	
Connector for Microsoft Outlook Security Guide








Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.


Access to Oracle Support

Oracle customers have access to electronic support through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.












1 Getting Started

This chapter provides an overview of Oracle Communications Connector for Microsoft Outlook.


Deploying Connector for Microsoft Outlook

Connector for Microsoft Outlook enables users in your organization to use Microsoft Outlook as their email, calendar, address book, and Global Address List (GAL) client while connected to Unified Communications Suite servers. Connector for Microsoft Outlook must be installed and configured on each user desktop to facilitate the necessary ongoing communications between Microsoft Outlook and the server. The Connector for Microsoft Outlook software is installed one desktop at a time by a Setup Wizard that can also upgrade or convert any existing Microsoft Outlook data files to a format that the new software can read and use.



About Deployment Connector for Microsoft Outlook

To simplify both the administrator's work associated with deployment and the user's tasks in actually installing and configuring the new software, Oracle provides a deployment configuration program. This tool lets the administrator create customized end-user installation packages for the software, with pre-set configuration parameters to simplify and streamline the user's process, and to enforce any configuration settings the administrator deems necessary or desirable for a particular user or group of users. The deployment configuration program saves those pre-set configuration parameters in an .ini text file, and then bundles the .ini file with an installation program, the Setup Wizard, for end users. When an end user activates the package, the Setup Wizard reads the .ini file to install and configure the Connector software on the user's desktop according to the administrator's specifications.

A system administrator may create different installation packages for individual users or for groups of users. For example, to provide different configuration schemes for users in the Sales department versus the Engineering department and so forth, or to offer configuration options to some groups of users while setting fixed parameters (eliminating the choices) for others.






Administrator's Process Overview

In a typical deployment scenario, an administrator will perform four primary tasks to deploy the Connector for Microsoft Outlook.


Deploying the Connector for Microsoft Outlook

	
Prepare a comprehensive deployment plan.

Planning and foresight are critical to a smooth deployment. The process of developing a comprehensive deployment plan is a valuable exercise that will lead you to consider and accommodate all of the factors likely to influence your organization's migration. The deployment information in Connector for Microsoft Outlook Installation Guide describes important migration concepts, prerequisites, and strategic choices, and explain how to develop a deployment plan that will guide you through your migration. Every administrator should therefore read these sections and prepare a comprehensive deployment plan.


	
Install the deployment configuration program.

The administrative software obviously must reside on the administrator's computer before it can be used to create end-user installation packages. See Connector for Microsoft Outlook Installation Guide for more information.


	
Configure end-user package.

"Configuring End-User Packages" explains how to use the deployment configuration program to create customized packages for Outlook end users. These packages can be configured to install the necessary software on user desktops, or to convert users' existing Outlook data files for use with the new software or both, depending on your circumstances.


	
Deploy each end-user package.

Create an installation package for your users. Many administrators simply copy the package to a shared folder, and then provide links to the installation package in an announcement email to users.




Steps 1 and 2 of this process overview are a good place to start regardless of your unique configuration and preferences. If your migration strategy calls for two or more different installation packages for different users or user groups, simply repeat steps 3 and 4 for each package until all users have been migrated.

The deployment process can proceed along different paths depending on your original and destination network configurations, the administrative structure of your organization, and your own informed sense of the extent to which your users should be involved in the process of installing and configuring their own desktop software. Moreover, your network configuration or preferences may dictate some variation to the standard scenario described above. "Application Notes for Special Circumstances" provides application notes for the most common of these variations.
















2 Configuring End-User Packages

This chapter describes how to create and configure a single Oracle Communications Connector for Microsoft Outlook desktop installation package for end users. If the most recent version of the Administrator's software is not yet installed on your computer, see Connector for Microsoft Outlook Installation Guide. The administrator's software must be properly installed on your computer before you can run the deployment configuration program.


About Desktop Installation Packages

Follow these instructions to create a single desktop installation package for a single user, or for a particular group of users who will all install and configure the Connector for Microsoft Outlook in the same way. To create multiple desktop installation packages with a variety of configuration settings for different groups of users, repeat this procedure for each package you want to create.


Creating a Single End-User Desktop Installation Package

	
In order to install Connector for Microsoft Outlook Connector, you need to download Visual C++ Redistributable for Visual Studio 2012. You can download Visual C++ Redistributable for Visual Studio 2012 from: http://www.microsoft.com/en-US/download/details.aspx?id=30679

There are separate executables for 32-bit and 64-bit installations:

	
vcredist_x86.exe


	
vcedist_x64.exe




After downloading and running one of the redistributable executables, you can proceed to install Connector for Microsoft Outlook.


	
Locate and launch (double-click) the file Admin.exe, in C:\Program Files\Sun\Deployment Configuration Program.




	
Note:

During installation, the path of the Deployment Configuration Program can be configured.







You can also launch the program, Oracle Communications Connector for Microsoft Outlook Deployment, either as a desktop shortcut icon or from the Start program menu.

The deployment configuration program then opens a configuration window on your desktop. The configuration window contains:

	
Nine tabbed panels where you enter the information to characterize end user's configuration of the Connector for Microsoft Outlook (described separately below).




	
A Help button, which opens a separate window of information about the entry options available on the currently displayed panel.




	
Three menus: File, Tools, and Help. The File menu offers several standard, familiar Windows features for file management: New, Open..., Save, Save As..., Print Setup..., Print..., and Exit. The Help menu offers context-sensitive access to the online help system that accompanies this deployment configuration program. The Tools menu offers a Create Package feature that lets you create a new installation package for an existing.ini configuration file that has been opened into this configuration window. You may use Open... from the File menu to locate and open an existing .ini file.





	
Complete the information in the nine tabbed panels, as described separately (per tab) below. Click the tab to view the associated panel. If you begin creating an installation package but then decide to finish it at a later time, click Save from the File menu to create a partially completed package. Click Open... from the File menu to resume and complete your work at a later time.


	
When you have entered all of the information requested in the nine tabbed panels, click Save from the File menu to save your configuration choices in an .ini file and create a new installation package. Clicking Save activates a standard, familiar Windows Save dialog box.


	
In the dialog box, enter an appropriate path and filename for the .ini file and .exe file, and click the Save button. The Save command actually creates two new files: the .ini file, which is saved in the folder you designate in the Save dialog box, and an .exe file (the bundled installation package, including a copy of the .ini file), which is saved by default to the same folder where the .ini file is saved. Both the .ini and .exe files carry the filename you designate in the Save dialog box.





Troubleshooting

If the program reports a logon failure or "Could not locate..." a necessary resource while it is running, and if you know that the resource exists in the location that you have specified, then the administrator account you are using to run the deployment configuration program is not authenticated to the file server where the resource resides. Make sure that you are logged in to the locations of all such resources and then run the deployment configuration program again.









Processes Tab

Use the Processes Tab to select Silent or Interactive user mode, use processes to be included in the configuration, log file settings, status file settings, and the inputting of optional notes about this configuration.


User Mode

You can choose to install the package in any of the two modes. These two modes, silent installation vs. interactive, are mutually exclusive:

	
Silent: The user program will install and configure the user's software without any user involvement whatsoever, according to the administrator's preset parameters for this process (as set in this and the other tabs in this deployment configuration program).


	
Interactive: The user program will present the user with at least some choices for the installation, configuration, and conversion processes. The extent of user involvement will be as determined by the administrator (as set in this and the other tabs in this deployment configuration program).








Processes to Include in this Configuration

The installation of these software components to user desktops will require access privileges that often are disallowed to many or most end users. If your network serves "locked-down" Windows environments where end users cannot install the software, we strongly recommend a "push" method for software distribution from the system administrator to user desktops that bypasses the requirement for user access privileges. This "push" method of distribution is explained in "Push Method Deployment, If End Users Lack Installation Privileges".

For a full explanation of any or all of the processes offered in this panel, and the implications of installing or not installing them, see "About Connector for Microsoft Outlook Architecture" in Connector for Microsoft Outlook Installation Guide.

Install or Upgrade Connector for Microsoft Outlook. Tells the program to install the software that facilitates necessary ongoing communications between the user's Outlook client application and the Connector for Microsoft server. If Connector for Microsoft Outlook is already installed, the user program will check the installed version and, if appropriate, upgrade to the newer version.

See "System Requirements" in Connector for Microsoft Outlook Installation Guide.

The Connector for Microsoft Outlook Setup Wizard detects any discrepancy between these requirements and the actual installation environment, and in that case will not install Connector for Microsoft Outlook.

Create/Convert/Upgrade User Profile. Activates the User Profiles tabbed panel, so the user program can convert an existing eligible Outlook user profile or create a new profile for use with the new Connector. The user program will convert only an "eligible" profile, meaning that the profile must:

	
Include message services of at least one type designated in the User Profiles tabbed panel (in the Converted/upgraded Profile Settings section).


	
Not have been fully converted (all of its .pst files converted) by a previous run of the user program (although the remaining, unconverted .pst files of a partially converted profile can be converted).




If this box is not marked, the entire User Profiles tabbed panel will be grayed out and unavailable, and no user profile will be converted or created. For example, you may want to create a user installation package to simply install or update MAPI services without converting or creating any profiles.





Log File Settings

These settings pertain to the directory where the user program will write its log files for the user's migration session. The first two options are mutually exclusive:

	
Store log files locally: Tells the user program to write its log files to the user's local "temp" directory.


	
Store log files in a shared directory: Tells the user program to write its log files to a particular shared directory, which you must specify in the accompanying text box. Use the Browse ("...") button to locate and specify the path, or type it into the text box. You can enter a drive letter or a UNC path.


	
If the Browse feature for Log files does not display the location you need to specify (but you know that it exists): This is an unlikely scenario, but chances are you are not authenticated in the domain to which you have browsed. To correct this problem, right-click the target computer and select Explore, and enter your administrator user ID and password at the prompt. You may then return to the Browse feature and select the computer you need to browse.


	
Include debug logging: Tells the user program to log its activities in the more verbose, more explicit "debug" style. If a user encounters a problem with the installation package and you can't diagnose the problem by reviewing the default-style log entries, the more verbose debug-style logging may provide enough additional information to help you or your associates solve the problem. This option is off by default.








Status File Settings

Post a one-line status of user activity to a .csv file: Adds a one-line summary of user activity to the .csv file you specify in the accompanying text box. Each line represents one run of the desktop tool by a user. A single user who runs the tool multiple times should generate multiple lines in the .csv file.

If you mark this checkbox, you must also specify the shared file to which the status lines will be written. Use the Browse ("...") button to locate and specify the path, or just type it into the text box. If the file already exists, it will be updated each time the installation kit is run.





Notes (optional)

Any notes or comments you care to include about this configuration can be entered into this field.







User Profiles Tab

This section describes the User Profiles Tab.

The settings in the User Profiles panel apply only if this package creates, upgrades, or convert user profiles. Beginning with Connector for Microsoft Outlook 8.0.2, you can select multiple options in the User Profiles Tab to create, upgrade or convert profiles.


User Profile Settings

Mark options in this section to specify whether and how user profiles are upgraded, converted, and created:

	
Create Profile Settings: Tells the user program to create a new Outlook user profile, ignoring any existing profiles that may already exist for the user. Note that if a user attempts to run the installation with the same profile name more than once, an error occurs.


	
Upgrade Profile Settings: Tells the user program to upgrade an existing Outlook user profile if it can find one. If it cannot find an existing profile, it does not create a new one:

	
In Silent Mode: Upgrades the user's default profile if it can be found, or does nothing if a default profile cannot be found.


	
In Interactive Mode: Prompts the user to select a single profile to upgrade if it finds it.




	
Note:

Selecting the Upgrade checkbox sets the property: ModifySun71PlusProfile in the .ini file.
Setting a new profile name sets the UpgradeProfileName property. Changing the existing profile name sets the UpgradeChangeProfileName property.










	
Convert Profile Settings: Tells the user program to convert an existing Outlook profile, as follows:

In Interactive Mode:

	
Two or more eligible IMAP/POP profiles


	
Only one eligible profile that is not set as the user's default.

If the program finds only one eligible profile, and it is set as the user's default, the program automatically converts that profile without any user interaction.

If the program finds no eligible profiles, it does nothing — neither converts nor creates any user profile. The user program will convert only an ”eligible” profile, meaning that the profile must not have been fully converted (all of its .pst files converted) by a previous run of the user program (although the remaining, unconverted .pst files of a partially converted profile can be converted).




In Silent Mode:

	
Not supported when converting existing profiles.







	
Note:

Setting a new profile name sets the ConvertProfileName property. Changing the existing profile name sets the ConvertChangeProfileName property.













If the program finds no eligible profiles, it creates a new one.


Converted/Upgraded Profile Settings

If converting/upgrading, select the types of profiles eligible for conversion/upgrade: Check the box(es) that correspond to the profile type(s) that the user program should consider "eligible" for conversion. Remember that an "eligible" profile must include message services of at least one type designated here, and must not have been fully converted (all of its .pst files converted) by a previous run of the user program (although the remaining, unconverted .pst files of a partially converted profile can be converted).

Note that different types of data associated with different profile types are migrated differently, as shown in Table 2-1.

If converting or upgrading, change the profile name to the following: The name by which the converted profile will be identified in the drop-down list that appears on Outlook's user login screen.


Table 2-1 Destinations of Migrated Data from Various Sources

	Microsoft Outlook Component	Migrating From Microsoft POP	Microsoft IMAP
	
Mail

	
SJOC-local.pst

	
SJOC-local.pst


	
Contacts

	
Address Book Server

	
Address Book Server


	
Calendar

	
Calendar Server

	
Calendar Server


	
Tasks

	
Calendar Server

	
Calendar Server


	
Sticky Notes

	
SJOC.pst

	
SJOC.pst


	
Journals

	
SJOC.pst

	
SJOC.pst











Created Profile Settings

These options apply only to new profiles that the user program creates, and not to converted or upgraded profiles.

	
Name for new profiles: The name by which the new profile will be identified in the drop-down list that appears on Outlook's user login screen.


	
Set new profile as default: If this box is checked, the new profile will be set as the user's default Outlook profile.










Authentication

Disallow password based authentication: If checked, password-based authentication is not used. Instead, certificate-based authentication is used. To use this feature, the back-end services should be configured for certificate authentication.

Save Password

	
Always ask: Tells the user program to prompt the user for a password upon each login, or save (”remember”) the password so the user can skip that login step. Within the user program, the instructions displayed with the checkbox explain: ”If checked, you will not need to enter your information each time you launch Outlook.” This option is not available in any user package configured to run in Silent mode.


	
Always save: Tells the user program to not offer the user the choice described above (for Give user the option...). Instead, the screen will display this message: ”Your password will be saved. You will not need to enter your password each time you launch Outlook.”


	
Never save: Tells the user program to not offer the password choice, and to configure Outlook to always prompt for the user's password, by default. The user program will display no checkbox or related explanatory text.










User .pst Tab

This section describes the User .pst Tab.

The settings in the User .pst panel define how the program will save users' personal storage folders (.pst) files. Depending on your choices in other panels in this program, certain sections of this screen may not apply and may appear grayed-out (unavailable) in the display.


General Settings for Personal Storage Folder (.pst) Files

Size for new Connector for Microsoft Outlook... .pst: ____ MB: The expected amount of disk space required for the new .pst file into which selected items from old IMAP or POP servers are copied. The user program aborts the conversion if a user does not have this much disk space available. Leave this value set at its default, unless you have some particular reason to expect that your .psts will be larger.





IMAP/POP Profile Settings for .psts

Migrate POP/IMAP .pst Calendar and Tasks to Oracle Communications Unified Communications Suite Server: Tells the user program to migrate the user's POP/IMAP calendar data and tasks to the server. If this option is unmarked, no calendar data or tasks will be migrated. Note that Contacts are migrated by default, so no settings are needed for Contacts.

Associate all existing desktop data with the new Connector for Microsoft Outlook profile: Tells the user program to associate the user's existing POP/IMAP desktop data with the new Connector for Microsoft Outlook profile. If selected, the local .pst file is not deleted.







Servers Tab

This section describes the Servers Tab.


Server Settings

Server Name: The host name for each Oracle Communications Unified Communications Suite server: Incoming Mail (IMAP), Outgoing Mail (SMTP), LDAP (Global Address List and User Settings), Address Book (WABP), Calendar (WCAP), and Free/Busy (WCAP).

Port: The default port number for each server. The default changes if you use SSL to connect to the server.

Use SSL: Mark this box to require an SSL to connect to the associated server. By default, this box is already marked.




	
Note:

If the Use SSL box is not marked for the Calendar server, the Free/Busy server values will be the same as for the Calendar, and the Free/Busy line will therefore be grayed out in this panel. But if Use SSL is marked for the Calendar, then you must specify a different port for Free/Busy.







Default: Restores all Port numbers back to their original default values (if you have changed the values but now want to restore the defaults). The default values for SSL vs. non-SSL are different, and this feature will restore the appropriate default for any given server depending on whether the Use SSL box is marked.







Mail Tab

This section describes the Mail Tab.


Incoming Mail (IMAP)

Offline settings (two options, mutually exclusive):

	
Download messages locally to Inbox when going offline: Configures mail server to download messages to the user's Inbox when the user goes offline. Alternatively, the user can set the caching status of a given mailbox by highlighting the folder entry in Outlook, then executing the Properties menu, clicking the Mail tab, and selecting the Cache all message parts (attachments) for this folder option.


	
Do not download messages locally if they are larger than: ____ KB: The per-message size limit for the message server's local message cache. This option is intended primarily to reduce download times when the user goes into offline operations. This value, however, will also affect re-display times in online mode, because the message will have to be re-retrieved if it hasn't been cached.




IMAP Folder Name Mapping Options: Select either Outlook style or Convergence style to indicate which of these two standards the user program should use to name users' IMAP folders. Your selection here determines which of the two map files, outlook_folders.map or uwc_folders.map, will be used to map users' IMAP folder names. An administrator may, before running this program, edit these files to suit local requirements, as long as the original file names remain the same.

Polling:

	
Check for new messages every: ___ minutes: This is the interval, in minutes, after which a server mailbox will be polled for newly arrived messages. If any new message has arrived, the mailbox is refreshed and redisplayed in Outlook. If this field is cleared or set to zero, no polling will be done for this server connection.


	
Enable polling for all folders: Enable this checkbox if you want Connector for Microsoft Outlook to poll all folders, including your Inbox, for unread messages. The default, if this checkbox is not enabled, is to poll only your Inbox. This option can be useful if message filters have been set up to automatically move incoming messages to specific users' folders other than the Inbox, or if the direct delivery to a specific folder option has been enabled.








Outgoing Mail (SMTP)

BCC all sent messages to self: Configures the user software to automatically insert the user's email address into the BCC field of every outbound message (effectively lets a sender file a copy of every message sent). The messages are filed within a sender's server INBOX, and subsequently will be affected by any server-based message filtering rules.

Requires authentication: Tells the user software to configure the SMTP Service so as to require user authentication for outbound SMTP mail.







LDAP Tab

This section describes the LDAP Tab. The tab lets you specify the settings for the LDAP Directory Service.


Global Address List

The Global Address List (GAL) is a read-only MAPI Address book for Outlook users to view, search, and extract address information of the users, user groups, and calendar resources stored in the corporate directory. The corporate directory here refers to an LDAP server storing user account information including user name, passwords, contact information, and so on. This enables other authorized users on the same network to access the information. Connector for Microsoft Outlook GAL enables Outlook to display the corporate directory as "Global Address List" in conjunction with Contacts, personal address book, and any other address book providers. The GAL provides access to details of individual users, static groups, and calendar resources stored in the corporate directory.

The back-end server or the server that is referred to as the corporate directory can be any LDAP address book server adhering to the predefined schema. Here, the term 'user' means the individual whose data or information is stored as an entry in the server.

In order to allow browsing of the directory, Connector for Microsoft Outlook utilizes the Virtual List View (VLV) and server-side sort extension of the directory server. The directory server must be configured for the VLV index. The VLV index is precisely defined by a basedn, search filter, sort attribute, and scope. Any mismatch amongst the settings described below and the VLV index settings on the server results in poor performance.

Search base: The LDAP distinguished name of the root of your LDAP directory. Use the pattern specified in the User DN pattern fields.

LDAP Mapping String: Contains mappings for the GAL and LDAP directory. Connector for Microsoft Outlook maps the LDAP attributes to the corresponding display items in Outlook as per the mappings provided here. If you change any of the mappings in the LDAP Mapping attribute, these changes should also be made to the LDAP configuration attributes in VLV filter, Advance Search and Name Resolution Filter.

VLV Search filter: The filter that is used for the VLV to display entries within the directory.

Advanced search filter: Determines what fields are used when searching for users within the GAL. You can change this field if you wish to customize the GAL's Find dialog.

Name resolution filter: Determines which fields to search when entering a name while composing a new message. Outlook tries to resolve the name after pressing Ctrl-K or selecting Check Names from the Tools menu.

VLV sort attribute: The LDAP sort key for the Global Address List. The default value is cn.

Search times out after: ___ minutes: Limits directory search times to the designated number of minutes.

Maximum number of search results returned: Limits the number of entries returned by a search to the number specified here.

Show `Member Of' tab in contact properties dialog: Displays the static LDAP groups to which the selected user belongs.

Require authentication: Tells the user program to configure the LDAP Directory Service so as to require user authentication in the form of a user Distinguished Name (DN) for each directory query. This option is selected by default, and will require you to specify the User DN pattern in the relevant field.

User DN pattern: The elements of the user's Distinguished Name that, when assembled, will form the complete DN to authenticate the user's identity to the LDAP Directory Service (if authentication is required).

The recognized keywords for the DN pattern are:

	
%s the full user ID.


	
%user the left part of the user ID (left of the @ symbol) if the user ID includes the domain (for example, john@florizel.com). If no @ symbol appears in the user ID, the full user ID is used.


	
%domain the right part of the user Id (right of the @ symbol) if the user id includes the domain.




For example, to define a DN consisting of a user ID (uid), an organization unit (ou) and an organization (o): uid=%s,ou=people,o=florizel.com. The user's ID replaces %s after configuration of the user's profile.

If, for example, the user ID includes the domain (john@florizel.com), the DN pattern is: uid=%user,ou=people,o=%domain,o=isp. This will be replaced with uid=john,ou=people,o=florizel.com,o=isp.

Similarly, to define a DN consisting of a common name, an organization and a country: cn=Fred Smith,o=florizel.com,c=US.





User Settings

The user settings are used to extract information about the user. This information can be used to determine "out of office" settings and how the user's name and email address is displayed when sending email.

Retrieve user settings from LDAP: Enable this checkbox if you want your user settings extracted from LDAP.

User DN pattern: The elements of the user's Distinguished Name that, when assembled, will form the complete DN to authenticate the user's identity to the LDAP Directory Service (if authentication is required). Use the pattern specified for the User DN pattern field for the Global Address List.

Warn user at startup when out of office message is turned on: If this checkbox is enabled, a dialog box appears when Outlook is started warning the user that the out of office message is turned on. The user can choose to turn off the out of office message with this dialog.

Retrieve full name and email address from LDAP server: Enable this checkbox if you want the display of your name and email address updated from the LDAP server.







Calendar Tab

This section describes the Calendar tab.


Calendar Settings

Oracle Communications Calendar Server Settings: Sets the URL path portion to the server information. This is the URL used to connect to the Calendar Server 7 from Outlook. The default URL is


http://server:80/davserver/wcap


This applies to Calendar Server 7 only. If you are connecting to Calendar Server 6, leave this field blank.

Synchronize Outlook calendar with calendar server every: ___ minutes: Specifies how often the Outlook calendar will synchronize with the calendar server.







Address Book Tab

This section describes the Address Book tab.

Oracle Communications Address Book Server Settings: Enter the portion of the address book web client URL that follows the domain root and a delimiting slash character. The root value appears in the grayed-out text box to the left of this value, drawn from your Address Book Server entry on the Servers panel.

To use Convergence address book server, enter iwc/svc, which is the default.

Polling: Synchronize Outlook Address Book with Address Book Server every:_____ minutes: Enter the time interval (in minutes) after which Outlook Connector should synchronize with the Address Book Server. By default, the time interval is 5 minutes.

Outlook Address Book Settings:

	
Show this address list first: Select Contacts or LDAP Directory (mutually exclusive) to indicate which of these two should appear first in the user's Outlook Address Book.


	
Directory search order: Select Contacts first... or LDAP Directory first... (mutually exclusive) to indicate how Directory searches should proceed.








Single User Tab

This section describes the Single User tab.

The Single User tabbed panel lets you specify and authenticate the identity of a single specific user. This panel applies only if you are creating an installation kit for one particular user. For example, your CEO, or for some other user whose unique circumstances warrant a more customized configuration.

Full name: The "friendly" name associated with the user's email address. When sending messages, this name appears in the From box of the user's outgoing messages.

E-mail address: Specifies the email address that people should use when sending mail to the user at this account--- must be in the format name@florizel.com.

Login name: Specifies the user's account name, which must be the same value for both the IMAP and calendar servers. This is often the same as the part of the user's email address to the left of the "at" sign (@).

Password: The user's account password, which must be a single shared password used for both the IMAP and calendar servers.

Password confirm: A duplicate field for the user's account password, required as a precaution against typographical errors. (This value must match the Password value above.)












3 Application Notes for Special Circumstances

The chapter explains how to deploy Oracle Communications Connector for Microsoft Outlook under certain special circumstances or network configurations.



Push Method Deployment, If End Users Lack Installation Privileges

The deployment configuration program lets an administrator create installation packages that end users can run to install and configure their own local desktop copies of the Connector for Microsoft Outlook software. Software installation, however, requires access privileges that often are disallowed to many or most end users. Most enterprises therefore implement a push method for software distribution from the system administrator to user desktops that bypasses the requirement for user access privileges. If your network serves locked-down Windows environments where end users cannot install software, we strongly recommend this sort of automated configuration management as a way to avoid many individual desktop visits.

This section describes a push method for distributing the Connector for Microsoft Outlook to user desktops using Microsoft's SMS administration tools. Remember that the deployment configuration program can prepare desktop installation packages that both install the Connector for Microsoft Outlook software and convert existing Outlook profiles and data files for use with the new software. If your users had sufficient administrator privileges to install new software on their own desktops, you could prepare a single installation package that would perform both the installation and conversion functions in a single pass. But if the user who runs the installation package lacks the administrator privileges to install software, then the installation portion of the package would be unable to run and the conversion would fail.

When users cannot install their own software, we have to separate those two tasks so that the installation function can be facilitated separately by an SMS installation package. The SMS installation package can then be run on each user desktop by a local SMS account that has full administrator rights, and is therefore authorized to install new software on the local desktop. After the necessary software for the Connector for Microsoft Outlook has been installed, we use the deployment configuration program to prepare a second installation package to convert any existing Outlook profiles and data files for use with the new Connector for Microsoft Outlook.

The conversion functions will convert any existing Outlook profiles and data files associated with the specific user who is running the desktop installation program. But the SMS account that will run the first installation package is a generic account, with administrator privileges so that it can install software, but not associated with any particular user. The installation tasks and conversion tasks must therefore be performed by two separate installation packages, because the generic SMS account necessary to physically install the software lacks the user specificity necessary to convert a user s existing profile and data files.

A typical SMS push scenario consists of the five steps detailed below.


Deploying the Push Method

	
Prepare the necessary shared folders. Create two new shared directories, named LOGS and WPW, on a computer that is part of the same SMS site as the end-user desktops. The nature of Windows NT local accounts requires that you assign full control share permissions for all three folders for the SMSCliToknLocalAcct$ account. These assignments will provide the necessary read/write access to these directories for the SMS local account (which requires a password), and lets you avoid having to open the system to guest access. Also, assign full control permissions for all three of the NTFS folders to SMSCliToknLocalAcct$.


	
Prepare an installation package to install the necessary software. Use the Connector for Microsoft Outlook deployment configuration program (Admin.exe) to create an installation package that will only install the necessary software to each user's desktop, but not convert existing Outlook profiles and data files. The Admin.exe program is described in "Configuring End-User Packages", but note these special requirements, on the Processes tab, for preparing this package for SMS distribution:


	
	
Be sure the User mode is set to Silent.


	
Be sure to uncheck the option to Create/convert/upgrade user profile.


	
Use UNC paths (\servername\sharename) for all three of the path fields.





	
Push the first installation package to user desktops via an SMS installation package. Use Microsoft's SMS Packaging Wizard to prepare an installation package that will contain the Connector for Microsoft Outlook installation package you created in step 2, and then push the package to run automatically on user desktops without any user initiative or interaction.

	
Launch the SMS 2.0 Management console. Right-click on the collection to which you want to push the Connector for Microsoft Outlook, and click Distribute Software. SMS then launches its Distribute Software Wizard.


	
On the Distribute Software Wizard's Welcome screen: Click Next to begin.


	
On the Package screen: Click the option to Create a new package and program, and click Next.


	
On the Package Identification screen: Enter the appropriate values and click Next.


	
On the Source Files screen: Select Create a compressed version of this source, and click Next.


	
On the Source Directory screen: Click the Browse button to locate and specify the directory where the Connector for Microsoft Outlook installation package was created. The path specification can be either local or UNC. When you have specified the correct path, click Next.


	
On the Program Identification screen: Click the Browse button to locate and specify the name of the program .exe file for the Command line, and click Next.


	
On the Program Properties screen: Make sure the program will Run with administrative rights, and click Next.


	
Specify whether and how you want to advertise the program on the next five screens, titled: Advertise a Program, Advertisement Target, Advertisement Name, Advertise to Sub collections, and Advertisement Schedule. As you enter your choices, click Next to advance to each next screen.


	
On the Assign Program screen: Select Yes to assign the program, specify the date and time of assignment, and click Next.


	
On the Completing... screen: Review your settings for the creation of this installation package. You may use the Back button to go back and change any settings now, before you actually create the package. When the settings appear as you want them, click Finish to create the package, which will then be pushed to user desktops according to the Assignment and other parameters you have specified in this Wizard. A user s Advertised Programs Monitor will report the package. In any case, every user will be alerted to the imminent run of the package by a Countdown dialog box. Because the desktop installation program (desktop.exe) will be run by the SMS administrator program, as a local user, access to network shares will require a password, even if the shares are made available to the group everyone. If the network denies access to log directories and install directories during a user run of the installation package, enable guest access on the computer hosting the log files and installation media, to allow the local account from one system to access the data from another system.





	
Prepare a second installation package to convert existing Outlook profiles and data files. Use the Connector for Microsoft Outlook deployment configuration program (Admin.exe) to create a second installation package for the Connector for Microsoft Outlook this time to only convert any existing Outlook profiles and data files for use with the new Connector for Microsoft Outlook software. The Admin.exe program is described in "Configuring End-User Packages", but note these special requirements in the Processes tab for preparing this package:

	
Set the User mode to Interactive.


	
Under Processes to include in this configuration:

	
Be sure that none of the Install or upgrade... options is marked.


	
Mark the Create/convert/upgrade user profile option.








	
Push the second installation package to user desktops via an SMS installation package. Use Microsoft's SMS Packaging Wizard to prepare another SMS installation package this one to contain the installation package you created in step 4. Use the same settings you used in step 3 above to prepare the first SMS installation package, except for these differences on the Program Properties screen:

	
Program can run: Select the option Only when a user is logged on.


	
Mark the User input required option, and be sure that Run with administrative rights is unmarked. This final SMS package will require some user interaction, to reply to password prompts, but will not require administrator privileges since this package does not install any new software to the desktop. The passwords will authorize the conversion program s access to password-protected Outlook Personal Folders (.pst) files. Alternatively, this step can be accomplished by running the installation package from the command line, with an SMS script, as explained below under "Command-Line Switches for the User Installation Package".














Command-Line Switches for the User Installation Package

Step 5 of the push method described above (see "Push Method Deployment, If End Users Lack Installation Privileges") can also be accomplished by running the installation package from an SMS script, with command-line switches to pass the necessary user passwords to the conversion program as it runs. This would make possible a truly silent installation and configuration, requiring no user interaction whatsoever.

For example, you might create an SMS package that runs a conversion package, and have the SMS services issue the following commands when it is run:


DT_Package.exe



/USERNAME=bcarpenter



/FULLNAME="Burns Carpenter"



/EMAILADDRESS="burns.carpenter@florizel.com"



/DN="uid=bcarpenter,ou=people,o=florizel.com,o=florizel.com"





	
Note:

This and other command-line samples are formatted here for ease of reading, but all of the switches must be typed in one continuous string which is likely to wrap to multiple lines of its own accord.







You could then substitute environment variables for the users (assuming that the Windows usernames and the Oracle usernames match):


DT_Package.exe



/USERNAME=%username%



/FULLNAME="Change This"



/EMAILADDRESS=%username%@florizel.com



/DN=uid=%username%,ou=people,o=florizel.com,o=florizel.com


This command-line approach would permit a silent (or minimally interactive) installation from SMS, which would probably generate far fewer Help desk calls than asking users to click a link in an email and requiring users to enter data.

The installation package will support these command-line switches:

	
/USERNAME=xxx, where xxx is the username on the Oracle servers.


	
/FULLNAME=xxx, where xxx is the display name of the user.


	
/EMAILADDRESS=xxx, where xxx is the email address of the user.


	
/DN=xxx, where xxx is the user DN on the Oracle servers.


	
/NEWPROFILENAME=xxx, where xxx is the name of the created profile.


	
/SAVEPASSWORD=n, where n = 1 (save) or 0 (don't save).


	
/ALTPSTDIR=dir, where dir is the directory where the local cache is created. If this switch is not present, the default value is Documents and Settings%username%\Local Settings\Application Data\Sun\Outlook Connector









About Outlook as the Default Client

Connector for Microsoft Outlook can be installed only at workstations where Microsoft Outlook is set to be the default email client. If Outlook is not set as a user s default email client, the Setup Wizard will not install the software, and will prompt the user to correct the problem and run the Setup Wizard again.


Designating Microsoft Outlook as a User's Default Email Client

If you are running Windows 7 or Windows Vista:

	
Click the Start Menu.


	
Select Default Programs.

The Default Programs window is displayed.


	
Click Set your default programs from the "Choose the program that Windows uses by default" list.

A list of available programs is displayed in the left panel.


	
Click Microsoft Office Outlook from the programs list.

A description of this program appears in the right panel.


	
Click Set this program as the default button.


	
Click OK.

You may then restart the Setup Wizard to install the software on your desktop.




If you are running Windows 8:

	
Click the Start Menu.


	
From the Control Panel, click All Control Panel Items.


	
Click Set your default programs.


	
Click Microsoft Office Outlook from the programs list.

A description of this program appears in the right panel.


	
Click Set this program as the default button.


	
Click OK.

You may then restart the Setup Wizard to install the software on your desktop.











About Removing Sun Java System Synchronization Program

The MAPI services for the Connector for Microsoft Outlook are a required component of the Connector installation, but cannot coexist with the Synchronization Program. If the synchronization program is installed on a user s workstation, the Setup Wizard will notify the user of the problem (in an error message after the Welcome screen), and prompt him or her to acknowledge the notice and exit the program. The user may then rerun the Setup Wizard after the synchronization program has been removed.


Removing the Synchronization Program from a User's Workstation

	
From the Start menu: Select the Uninstall... option for the program you want to uninstall. Choose one of the following options:

	
Uninstall Sun Java System Synchronization Program from Sun Java System Synchronization Program in the Programs menu.


	
Uninstall Sun ONE Synchronization (old version of Synchronization Program) from Sun ONE Synchronization Program in the Programs menu.





	
In the Uninstallation window: Follow the prompts to uninstall the software.


	
Click Finish to complete the uninstallation process. To synchronize a mobile device with Outlook, we strongly recommend that users use the sync software distributed with their devices, rather than the Sun Java System Synchronization program. Changing to the sync software distributed with a device may require uninstalling and reinstalling the desktop software. If a user wants to continue using the Synchronization program to sync to the data of the other device, he or she can reinstall the software, but not select the checkbox for the Microsoft Outlook 98/2000 translator during the installation.










About Undoing (Reversing) a User's Migration

To abandon a user's connection to the new Communications Suite server and restore the user s mailbox to service with the old Exchange server:


Reversing a User's Migration

	
Delete the profile Xxx (old).


	
Copy the profile Xxx to Xxx Oracle or some other name, like Xxx (new), and so forth.


	
Delete the profile Xxx.


	
Copy the profile Xxx (Backup) to Xxx.


	
Delete the profile Xxx (Backup).


	
Determine where the .pst files are located by viewing Properties on the profile. There is no standard location for .pst files, so the only reliable way to find them is to open the profile (now named Xxx) and, for each .pst service, click on Properties and note the path.


	
For each pst file: Rename Yyy.pst to Yyy.new, and rename Yyy.bak to Yyy.pst.


	
Determine where the .pab files are located by viewing Properties on the profile. There is no standard location for .pab files, so the only reliable way to find them is to open the profile (now named Xxx) and, for each .pab service, click on Properties and note the path.


	
For each .pab file: Rename Zzz.pab to Zzz.new, and rename Zzz.bak to Zzz.pab. The Yyy.bak and Zzz.bak files will be in the same directory.

















4 Support for Large PST Files

Oracle Communications Connector for Microsoft Outlook supports a Personal Storage Folder (PST) file size of 20 Gigabytes. Users of Microsoft Outlook 2007, Microsoft Outlook 2010, and 2013 will have larger PST files as their local store for Connector for Outlook compared to previous versions of Outlook.

To set the PST file in Outlook 2007 and higher, perform the following steps:

	
Click Tools from the main menu.


	
Select Accounts Settings from the tools list.


	
Click Data Files tab.


	
Click Add and select the type of storage as Office Outlook Personal Folders File (.pst) from the storage type list.


	
Click Finish.




The PST file is now set as the storage type.










5 Ability to Disable Save Password Field

This chapter provides the steps to disable the Save Password field with Oracle Communications Connector for Microsoft Outlook.


Disable Save Password Option

Connector for Microsoft Outlook supports a security feature that enables administrators to restrict users from saving the passwords in their profile. As a prerequisite to disabling this option, you must set the Disallow Save Password value to 1 in the Registry Editor.

To disable the Save Password option, perform the following steps:

	
Invoke deployment configuration program.


	
Click the User Profiles tab.


	
Select the Never Save checkbox.


	
Click Save from the File menu to accept the change. Every time you open Connector for Microsoft Outlook, you will be prompted to enter the password.















6 New Path For Deployment Program

This chapter describes the new path for deployment program with Oracle Communications Connector for Microsoft Outlook.


New Path for Connector for Microsoft Outlook Deployment Program

The program shortcut for Connector for Microsoft Outlook is stored in the Start menu in the following location:

Start/Programs/Oracle Communications/Oracle Communications Unified Communications Suite Connector Deployment












7 Customizing the Location of the PST File

This chapter describes the steps to customize the location of the Personal Storage Folder (.pst file) with Oracle Communications Connector for Microsoft Outlook.


Customizing the Location of PST Files

This feature enables administrators to decide the location of PST files on a user's machine. By default, Connector for Microsoft Outlook stores PST files at:


C:\Documents and Settings\username\Local Settings\Sun\Outlook Connector


To customize the location of PST file, perform the following steps:

	
Locate the string name ForcePSTPath in the following location in the Registry Editor:


HKEY_CURRENT_USER\Software\Microsoft\Office\OLCVersion\Outlook


	
Right-click and select Modify from the pop-up menu.

The Edit String window displays.


	
Change the path to point to the desired location. For example, you can change it to:


F:/Connector for Microsoft Outlook/Files







	
Note:

The OLCVersion for Outlook 2007 is 12.0, Outlook 2010 is 14.0, and Outlook 2013 is 15.0.


















8 Polling in Address Book

This chapter describes how to run polling for your address book with Oracle Communications Connector for Microsoft Outlook.


Polling in Address Book

Connector for Microsoft Outlook enables you to set an option to run polling at a certain time interval. This feature enables you to keep your address book updated without any manual intervention.

To reset the polling value, perform the following steps:

	
Invoke Connector For Microsoft Outlook deployment configuration program.


	
Click the Address Book tab.


	
In the Synchronize Outlook Address Book with Address Book Server option, change the value to your preferred time interval.

By default, the polling value is set to 5 minutes.















9 Ability to Customize Attribute Mapping and Global Address List Display Order

This chapter describes how to customize attribute mapping and global address list (GAL) display order.

Oracle Communications Connector for Microsoft Outlook maps the Lightweight Directory Access Protocol (LDAP) attributes to the corresponding display items in Outlook. You can now customize the LDAP attribute mapping and GAL display order by using the Connector for Outlook Deployment Program.

To customize the attribute mapping, perform the following steps:

	
Click the LDAP tab from the Connector for Microsoft Outlook deployment configuration program.


	
In the LDAP Mapping String option, change the attribute mapping to the desired value.

For example, you can change it to Firstname = given name, Dept = DeptID.




To customize GAL Display Order, perform the following steps:

	
Open the configuration (.ini) file from the location where you stored it when you created the profile.


	
Set the attribute to the desired display order. All .ini files will have an attribute GALDisplayOrder, which can be modified.




For example, you can set the GAL Display Order to the following:


GALDisplayOrder=Officephonenumber,Address,Title,Company,uid,PrimaryEmailAddress,AddressType


The first column is the attribute used in the "VLV sort attribute," which by default is cn (displayname), followed by OfficePhoneNumber in second column, then Address in third column, and so forth.

Consider what happens if you set the GAL Display Order to the following:


GALDisplayOrder=PrimaryEmailAddress,Officephonenumber,Address,Title,Company,uid,AddressType


The first column is still cn (displayname), but now it is followed by PrimaryEmailAddress in the second column, then OfficePhoneNumber in the third column, and so on.




	
Note:

The Virtual List View (VLV) sort attribute is used in the LDAP query as a sort attribute. This should be the same as the sort attribute used in the VLV index created at the server side or else performance could be degraded.
















10 Saving File Attachments in Optimized Mode

This chapter describes how you can use Optimized mode to save file attachments.

You can save the file attachments outside the PST using the Optimized mode. In Normal mode, the complete message including attachments are stored in the PST file locally. The Optimized mode reduces the local PST file size by not storing the message attachments in the PST. This mode is useful for virtual desktop environments, where the desktop is being stored in a centralized location and is downloaded every time a user logs into the network. The desktop data size that includes the PST file associated with the logged in user, will be reduced in the Optimized mode.

You need to configure to create a profile in either Normal mode or Optimized mode, default being Normal mode.

To configure Optimized mode, in the .ini file, set the following value:


OptimizePstStore=1


To configure Normal mode, set the OptimizePstStore value to 0.




	
Note:

Optimized mode is not recommended for normal desktop users because in this mode, the message and its attachments, when accessed, will be downloaded from the server in every login session.







The attachment data is stored in Windows temporary directory. The file format is as follows:


~oc-(timestamp)-(filename).(ext)



Limitations of the Optimized Mode

The Optimized mode has the following limitations:

	
Messages are stored in the Outbox when they are being sent from Outlook.


	
The attachments are in RTF format.


	
No optimization for messages stored in the Outbox when a message is being sent.


	
The PST used in Optimized mode is incompatible with PST used in Normal mode and vice-versa.


	
Upgrade from existing normal mode to optimized mode or vice-versa is not possible.


	
Switching between normal mode and optimized mode is not possible.




Optimized Mode does not support the following:

	
Offline Access


	
Autopreview (the message is not pre-loaded as in Normal mode)


	
Calendar attachments


	
Contacts/AB attachments















11 Certificate-based Authentication for Connector for Microsoft Outlook

This chapter provides an overview of certificate-based authentication for Oracle Communications Connector for Microsoft Outlook.


Overview

Certificate based authentication is one of the most secure authentication methods. It uses digital certificates which are stored locally in the system, (or in a smart card etc.) to authenticate a user, as opposed to using passwords.

Connector for Microsoft Outlook supports certificate based authentication for the following back-end services:

	
Mail access service: IMAP + SSL, IMAP + STARTTLS


	
Mail transport service: SMTP + SSL


	
Calendar service: WCAP + SSL


	
Address Book Service: WABP + SSL


	
Corporate Directory: LDAP + SSL


	
User preferences: LDAP + SSL




Connector for Microsoft Outlook supports smart-card certificates and software digital certificates.





Using Certificate-based Authentication with Outlook Connector

When logged into Connector for Microsoft Outlook, Outlook determines whether the server has been configured for certificate-based authentication based on the server's response to initiating a connection. If the server is configured for certificate-based authentication, Connector for Microsoft Outlook searches through the local system for eligible certificates with which to log into the server.

The eligible certificates are filtered by:

	
Certificates issued by "trusted CA" by the backend servers.


	
Unexpired certificates.


	
Certificates that can be used for SSL client authentication.




Connector for Microsoft Outlook prompts the user with the list of eligible certificates. The user selects the certificate with which to authenticate to back-end server. If certificate-based authentication fails, Connector for Microsoft Outlook falls back to password-based authentication and prompts user to enter a password to log in. This is also the case if the user doesn't select any certificates from the list.




	
Note:

If a user's profile is configured by an administrator to only support certificate-based authentication, the user will never be prompted for a password.







If certificate-based authentication fails and password based authentication succeeds for the mail server, then certificate-based authentication will not be attempted for other back-end services, such as SMTP, CS, AB and LDAP. If certificate based authentication succeeds, then certificate-based authentication will be attempted with other back-end services first. If certificate-based authentication fails, password-based authentication will be attempted.

If a user mistakenly chooses a certificate different than the certificate used during the last login, the user is warned that a different certificate is being used to logon from the previous attempt and is given an option not to continue.




	
Caution:

If both certificate-based and password-based authentication fails with the mail server, Connector for Microsoft Outlook will not proceed authenticating with other back-end services such as Address Book, Calendar Server and LDAP server.











Configuration

It is possible for an administrator to configure an Connector for Microsoft Outlook user profile such that an authentication certificate is used with the back-end services without the user having to choose the certificate.

A user can configure an Connector for Microsoft Outlook profile so that the certificate information is saved, thus allowing a user to log in without being prompted to select an authentication certificate.












12 Configuring Shared Calendar Name Format

The default Oracle Communications Connector for Microsoft Outlook calendar name format consists of a long and confusing name format, which is used to avoid name clash in Outlook.

The default, or legacy format, resembles the following:


Calendar - owner - calendar name(cal ID)


You use the SubscribedCalendarNameFormat (hidden) configuration attribute in the Connector for Microsoft Outlook configurator's .ini file to configure the value. It is stored in the following Windows registry key:


HKCU\Software\Sun Microsystems\Outlook Connector\Subscribed Calendar Name Format


The configuration attribute resembles the following:


SubscribedCalendarNameFormat=%u-%n


or


SubscribedCalendarNameFormat=legacy


where:

	
%u - %n


	
%u: Refers to the calendar owner name


	
%n: Refers to the calendar name (calendar ID, if no calendar name)


	
legacy: Specifies the default value (the format prior to patch 13)




Note the following restrictions on the configuration value format:

	
Cannot use any other separator characters.


	
%n is mandatory.


	
An invalid configuration reverts to the legacy format.


	
The default value for the registry attribute is legacy.


	
The configuration does not apply to the host folder name.




In the following examples:

	
sub: subscribed


	
cal: calendar


	
calname: calendar name




Example 1: "%u - %n"


Host folderName : sub cal owner name - sub calname



Sub cal folder name : sub cal owner name - sub calname



Sub Tasks folder name: sub cal owner name - sub calname - Tasks


Example 2: "%n"


Host folderName : sub cal owner name - sub calname



Sub cal folder name : sub calname



Sub Tasks folder name: sub calname - Tasks


Example 3: "%n - %u"


Host folderName : sub cal owner name - sub calname



Sub cal folder name : sub calname - sub cal owner name



Sub Tasks folder name: sub calname - sub cal owner name
 - Tasks
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